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Notice

1.

12.

13.
14.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT
TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)’ means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com

www.renesas.com/contact/.
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Renesas and the Renesas logo are trademarks of Renesas
Electronics Corporation. All trademarks and registered trademarks
are the property of their respective owners.

© 2022 Renesas Electronics Corporation. All rights reserved.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit
Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1.

Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must
be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be adequate.
When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. Semiconductor devices
must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches
and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar
precautions must be taken for printed circuit boards with mounted semiconductor devices.

Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of register
settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states
of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is
reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at which resetting is
specified.

Input of signal during power-off state

Do not input signals or an 1/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or 1/O pull-up
power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow the
guideline for input signal during power-off state as described in your product documentation.

Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in
the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an
associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.
Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program execution,
wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a reset,
ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an external
resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi (Max.) and
Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed,
and also in the transition period when the input level passes through the area between Vi. (Max.) and V4 (Min.).

Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these addresses
as the correct operation of the LSl is not guaranteed.

Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The
characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of internal
memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins,
immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given

product.



Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

¢ reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Smart Configurator for RX
together with the e? studio IDE to create a working project for the RSK platform. It is intended for users
designing sample code on the RSK platform, using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into e? studio, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX660 microcontroller may be found in ‘RX660 Group User’s Manual: Hardware’ and within the
provided sample code. The setup procedure for the RSK Web installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX660 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK Renesas Starter Kit for R20UT5017EG
hardware. RX660 User’s Manual
Tutorial Manual Provides a guide to setting up RSK environment, Renesas Starter Kit for R20UT5021EG
running sample code and debugging programs. RX660 Tutorial Manual
Quick Start Guide Provides simple instructions to setup the RSK and Renesas Starter Kit for R20UT5022EG

run the first sample. RX660 Quick Start Guide
Smart Configurator Provides a guide to code generation and importing Renesas Starter Kit for R20UT5023EG
Tutorial into the e? studio IDE. RX660 Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK. Renesas Starter Kit for R20UT5016EG
RX660 Schematics
Hardware Manual Provides technical details of the RX660 RX660 Group User’s RO1UH0937EJ
microcontroller. Manual: Hardware




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC

Analog-to-Digital Converter

API Application Programming Interface

bps bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

E1/E2 Lite Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

PLL Phase-locked Loop

Prmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification

PSU Power Supply Unit

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Real Time Clock

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TFT Thin Film Transistor

UART Universal Asynchronous Receiver/Transmitter

USB Universal Serial Bus

WwDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.



https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESANS

1. Overview

1.1 Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the e? studio
IDE Smart Configurator plug-in to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with e? studio.

« Code generation using the Smart Configurator plug-in.
« User circuitry such as switches, LEDs and a potentiometer.

The RSK board contains all the circuitry required for microcontroller operation.

R20UT5023EG0100 Rev.1.00 ——
Jan.17.2022 RENESAS



Renesas Starter Kit for RX660 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator plug-in for the RX
family together with the e? studio IDE to create a working project for the RSK platform. The tutorials help
explain the following:

e Project generation using e? studio

o Detailed use of the Smart Configurator plug-in for e? studio
¢ Integration with custom code

¢ Building the project in e? studio

The project generator will create a tutorial project with two selectable build configurations:
e ‘HardwareDebug' is a project built with the debugger support included. Optimisation is set to zero.

o ‘Release’ is a project with optimised compile options (level two) and ‘Outputs debugging information’
option not selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the e? studio debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more
in-depth information.

R20UT5023EG0100 Rev.1.00 S
Jan.17.2022 RENESAS




Renesas Starter Kit for RX660

3. Project Creation with e? studio

3. Project Creation with e? studio

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX660

MCU, ready to generate peripheral driver code using Smart Configurator.

This project generation step is

necessary to create the MCU-specific source, project and debug files.

3.2 Creating the Project

e Start e? studio and select a suitable location
for the project workspace.

Select a directory as workspace

» Recent Workspaces

e’ studio uses the workspace directory to store its preferences and development artifacts.

Workspace: | C¥Workspace ~ Browse...

[JUse this as the default and do not ask again

¢ In the Welcome page, click ‘Create a new
C/C++ project’.
(The Welcome page can also be opened
from 'Help'-> 'Welcome'.)

) Workspace - e studio
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

[ @ Welcome x o]

RENESAS

Welcome to e? studio

Create a new e studio C/C++ project

Import existing €2 studio projects from the
filesystem or archive

Get an overview of the features

Go through tutorials

Try out the samples
Download and import sample projects from v v
Renesas website

Find out what is new
Review the IDE's most fiercely contested
preferences

Quickly getting familiar with the tool

Open a file from the filesystem

[ Aways show Welcome at start up

R20UT5023EG0100 Rev.1.00
Jan.17.2022

RENESAS
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Renesas Starter Kit for RX660 3. Project Creation with e? studio

e In the ‘Templates for New C/C++ Project’ | | newc/css project o x
H . 13 il 3
dialog, selecting ‘Renesas RX' -> ‘Renesas | | remplates for New c/c++ Project
H 3
CC-RX C/C++ Executable Project’.
e Click ‘Next’. .
All GCC for Renesas RX C/C++ Executable Project
CMake EEZ A (/C++ Executable Praject for Renesas RX using the GCC
Make for Renesas RX Toolchain.
Renesas Debug . .
Renesas RL78 GCC for Renesas RX C/C+ + Library Project
FE=™ A G/C++ Library Project for Renesas RX using the GCC for
Renesas RX Toolchain.
Renesas CC-RX C/C++ Executable Project
FE==™ A G/C++ Project for Renesas RX using the Renesas CCRX toolchain.
Renesas CC-RX C/C++ Library Project
FE=™ A G/C++ Library Project for Renesas RX using the Renesas
CCRX toolchain.
@ < Back | Finish Cancel
e Enter the project name ‘SC_Tutorial’. Click | |& o x
13 t)
Next'. New Renesas CC-RX Executable Project =<
New Renesas CC-RX Executable Project e}
Project name: | SC_Tutoriall
Use default location
C:¥Workspace¥SC Tutorial Browse...
Create Directory for Project
default
Working sets
[] Add project to working sets New.
Select..
@ < Back Finish Cancel
R20UT5023EG0100 Rev.1.00 RENESANS Page 11 of 76

Jan.17.2022



Renesas Starter Kit for RX660

3. Project Creation with e? studio

In the ‘Select toolchain, device & debug ||@ o x
settings’ dialog, select the options as shown New R CC-RX Executable Project —
In the ScreenShOt OppOS|te- Select toolchain, device & debug settings =
¢ In ‘Toolchains’ choose ‘Renesas CCRX'. o
Toolchain Settings
e The R5F56609HxFB MCU is found under language:  @C OC++
RX600 > RX660 > Toolchain: Renesas CCRX v
. Toolchain Version: | v3.04.00 3
RX660 B 144 pln- Manage Toolchains...
e Select 'E2 Lite (RX)' from the pulldown and RTOS: None -
check 'Create Release Configuration' check RTOS Version:
box.
° C“Ck sNeXty Device Settings Configurations
: Target Board: |Custom V| Create Hardware Debug Configuration
Download additional boards... E2 Lite (RX)
Target Device: | R5F56609HxFB IZ' [] Create Debug Configuration
Unlock Devices... RX Simulator o
Endian: | Little =
. Create Release Configuration
Project Type: | Default
® < Back Finish Cancel
e In the ‘Select Coding Assistant settings’ | |& o x
dialog, select ‘Smart Configurator’. New Renesas CC-RX Executable Project —
L4 Click ‘Next’. Select Coding Assistant settings |

se Smart Configurator

Use Peripheral Code Generator *

Smart Configurator is a single User Interface that combines the functionalities of Code Generator and
FIT Configurator which imports, configures and generates different types of drivers and middleware
modules.

Smart Configurator encompasses unified clock configuration view, interrupt configuration view and
pin configuration view.

Hardware resources conflict in peripheral modules, interrupts and pins occurred in different types of
drivers and middleware modules will be notified.

(Smart Configurator is available only for the supported devices)

Application Code

I A
re Components

Device Drive!

Jojesndiuo) pYews

MCU Hardware

@ < Back Finish Cancel

o]

R20UT5023EG0100 Rev.1.00
Jan.17.2022

RENESAS Page 12 of 76



Renesas Starter Kit for RX660

3. Project Creation with e? studio

e Click ‘Next'.

&8 O X

New Renesas CC-RX Executable Project —

Settings The Contents of Files to be Generated
What kind of initialization routine would you like to create?

Use Renesas Debug Virtual Console

@ <Back ||  Next> | Finish Cancel

e A summary dialog will appear, click ‘Finish’ to
complete the project generation.

a8 m] X

New Renesas CC-RX Executable Project e

Summary of project "SC_Tutorial”

TOOLCHAIN NAME : Renesas CCRX
TOOLCHAIN VERSION v3.04.00
GENERATION FILES :

e In future, to skip the pop-up message on the
right, check the 'Remember my decision’
check box and click on 'Open Perspective'.

‘e Open the Smart Configurator perspective?
o

ﬂ’.emember my decision

Open Perspective No

e The perspective changes automatically when
the Smart Configurator starts up.

- O *

@~ QR ~@ FF I/ R[H~Q~
Q @ | BC/C++ & Smart Configurator

= O | 51 MCU/MPU Package x = B

=] ¥ a || £ yo 33
Generate Report

R20UT5023EG0100 Rev.1.00
Jan.17.2022
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Renesas Starter Kit for RX660 4. Smart Configurator Using the e? studio

4. Smart Configurator Using the e? studio

4.1 Introduction

The Smart Configurator plug-in for the RX660 has been used to generate the sample code discussed in this
document. Smart Configurator for e? studio is a plug-in tool for generating template ‘C’ source code and
project settings for the RX660. When using Smart Configurator, it provides the user with a visual way of
configuring the target device, clocks, software components, hardware resources and interrupts for the project;
thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are named ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where ‘xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

By following the steps detailed in this Tutorial, the user will generate an e? studio project called SC_Tutorial.
The fully completed Tutorial project is contained in the RSK Web Installer
(https://www.renesas.com/rskrx660/install/e2) and may be imported into e studio by following the steps in the
Quick Start Guide. This Tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for e? studio.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion. Results are
displayed via the virtual COM port in a terminal program and also on the PMOD display connected to the RSK.

Following a tour of the key user interface features of Smart Configurator in the tabbed pages (board, clocks,
components and pins), as well as a demonstration of building a project, the reader is guided through each of
the peripheral function configuration pages and familiarised with the structure of the template code, including
the process of adding their own code to the user code areas provided by the Smart Configurator
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4.2 Project Configuration using Smart Configurator

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the RX Smart Configurator User's Guide: e? studio.
You can download the latest document from: https://www.renesas.com/smart-configurator.

The Smart Configurator initial view is displayed as illustrated in Figure 4-1.

Q Waorkspace - SC_Tutorial/SC_Tutorial.scfg - € studio
File Edit Navigate Search Project RenesasViews Run Window Help
- DR >BHFR|rQUril~is e~ A AL I - - - v |

Q  ®| BC/C++ & Smart Configurator

1 Project Explore » | = B |8 SC Tutorial.scfg =N 3 MCU/MPU Package =8

% |4 | W | 1 Debug ~ | | SC_Tutorial HardwareDebug

=K H . 3 5| = = Bl = =" =
& SC_Tutorial e ot TioN Generate Code Generate Report Bl=ilp) sHgn-
= General Information v -
Overview

Get an overview of the features provided by

Smart Configurator.
Application Code

L7 Videos
Software Components
[,,.,, i ,,rﬁ‘

Drivers
What's New

Check out what's new in the latest release.
Product Documentation MCU Hardware

onfigurator

RTOS

Jojein8yuo) yews

= Current Configuration
Selected board/device: R5F56609HxFB (ROM size: 1 MB, RAM size: 128 KB, Pin count: 144)

Generated location (PROJECT_LOCY): |src¥smc_gen Edit.. -
Overview Board Clocks System Components| Pins| Interrupts » Legend
B Console x % bl @ | ™ O ~ 9~ = O | configuration Problems x =\
[smart Configurator Qutput 0 items
MO3000002: File generated:src)\smc gen‘\general\r smc cgc.c ~ | Description Type

MO3000002: File generated:src\smc gen‘general\r smc cgc.h

MO3000082: File penerated:src\smc gen‘general\r smc cgc user.c

MO4600001: File penerated:src\smc gen\general\r cg macrodriver.h

< >

v

Figure 4-1 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has
configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured e? studio project that builds and runs without error.
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4.3 The ‘Board’ tabbed page

On the ‘Board’ tabbed page, set the board type and device type.
Click the 'Board' tab and it will be displayed as shown in Figure 4-2.

E-

Device selection £
Device:  R5F56609HxFB

Download more boards...

Overiew Elocks System  Components| Pins| Interrupts
Figure 4-2 Board configuration page

4.31 Board configuration page

Make sure that ‘Custom User Board’ is selected for the ‘board:’.

Device selection

Device selection

Board: | Custom User Board W

Device: | R5F56609HxFB

Download more boards..

Figure 4-3 Select board
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4.4 The ‘Clocks’ tabbed page

The ‘Clocks’ tabbed page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected in the
r_bsp_config.h file in \src\smc_gen\r_config.

441 Clocks configuration

Figure 4-4 shows a screenshot of Smart Configurator with the Clocks configurations. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on board 24 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-4.

Clocks configuration 2 =

Generate Code Generate Report

SCKCR (FCK[3:00) FlashiF clock (FCLE)
SCKCR (ICK[3:00) System clock (ICLK)
pb— 12 - 120 (MHz)
' Main dock SCKCR (PCKA[3:0]) Peripheral module clock [PCLKA}
Oscillation source: | Resonator 2 b i)
SCKCR (PCKB[2:0]) Peripheral module chock (PCLKB)
quency 24 ™ B
— x1/4 - 60 Mkiz)
Oscillation wait time: i o
SCKCR (PCKD[300) Penpheral module clock (PCLKD)
G080 i al val e
p— x1/4 = 50 MHz)
SCKCR (BCK[3:0] External bus clock (BCLK)
b— x1/4 - . 0 (MHz)
Sub-clock
BCKCR (BCLKDMV)
SCKCR2 (CFDCK[3:01) CANFD clock ([CANFDCLK])
— x1/4 - &0 (MHz)
CANFDMCLK/CACMCLK
HOCO clock 24 (MHz)
OC0 clod
{DT-d clock

Overview Board S:mem Components | Pins| Interrupts

Figure 4-4 The ‘Clocks’ tabbed page

R20UT5023EG0100 Rev.1.00

RENESAS Page 17 of 76
Jan.17.2022



Renesas Starter Kit for RX660
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4.5 The ‘System’ tabbed page

Set the On-chip debug setting mode on the ‘System’ tabbed page.

System configuration
= On-chip debug setting
Debug interface setting
) FINE

() Unused @ ITAG

Note: The using of PC7/UB may have a imitation, because PC7/UB is

Overview Board Clocks omponents| Pins| Interrupts

() ITAG (Trace)

controlled for mode-settings by emulator

b | =

Generate Code Generate Report

Figure 4-5 The ‘System’ tabbed page

4.51 On-chip debug setting

The On-chip debug settings set the interface used for debugging. For the RSKRX660 CPU board, select as

shown in Figure 4-6.

= On-chip debug setting

Debug interface setting

() Unused (®) FINE O ITAG

() JTAG (Trace)

Figure 4-6 Debug interface setting
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4.6 The ‘Components’ tabbed page

Drivers and middleware are handled as software components in Smart Configurator. The ‘Components’ page
allows the user to select and configure software components.

Software component configuration

Components i1 5 |%. =] = 3 Configure

W

~ [= Startup
~ = Generic
% rbsp

Overview |[Board Clocks SystemlComponentslPins Interrupts

Figure 4-7 Components page

4.6.1 Add a software component into the project

Smart Configurator supports five types of software components: Startup, Drivers, Middleware, Application and
RTOS. In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple
project containing interrupts for switch inputs, timers, ADC and a SCI by component of Drivers.

Click the ‘Add component’ & icon.

Software component configuration

Components @23 7 = 3 Configure

"

~ [= Startup
~ [= Generic

% r_bsp
Figure 4-8 Add a Software component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
&) New Component O X

Software Component Selection tlj

Select component from those available in list

Category |All ~
Function All

Startu
Filter

Middleware

CompomApplication
8 8-Bit TINO>

Figure 4-9 Add a Software component (2)
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4.6.2 Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. Select ‘Compare Match Timer’ as
shown in Figure 4-10 below then click ‘Next’.

& New Component O * ‘
Software Component Selection EH’
Select component from those available in list
Category | Drivers |+
Function | All w
Filter | |
Components ? Short Name Type Version ~ I
B8 8-Bit Timer Code Generator 1.9.0
B# Clock Frequency Accuracy Measurem... Code Generator 1,100
# Clock Synchronous Control Module f..  r_flash_spi Firmware Integ.. 3.03
B Comparator Code Generator  1.8.1
B Compare Match Timer Code Generator 220 |
B Complementary PWM Mode Timer Code Generator  1.10.0
## Continuous Scan Mode S12AD Code Generator 1,120
8 CRC Calculator Code Generator  1.10.0
# D/A Converter Code Generator 1.10.0
B Data Operation Circuit Code Generator  1.10.0
B8 Data Transfer Controller Code Generator 1,100
f# Dead-time Compensation Counter Code Generator 1100 ¥
Show only latest version
Hide itemns that have duplicated functionality
Description
This software component provides configurations for 16-bit/32-bit timer with module
CMT/CMTW and can generate interrupts at set intervals.
Download the latest FIT drivers and middieware
Configure general settings...
|
@ < Back I Next » II Finish | Cancel
Figure 4-10 Compare Match Timer
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In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMTO0’ as shown in Figure 4-11
below.

& New Component O x> {

Add new configuration for selected component tl:f

Compare Match Timer

Configuration name: Conf ig CMTWO

Resource: CMTWO v

CMTWO
CMTW1

CMT1

CMT2
CMT3

2 < Back Next > Cancel
Figure 4-11 Select Resource - CMTO

Ensure that the ‘Configuration name’ updates to ‘Config_ CMTOQ’ as shown in Figure 4-12 below then click
‘Finish’.

&) New Component O X ‘
Add new configuration for selected component tl:f
Compare Match Timer
Configuration name: I_(onfig_CMT[J I
Resource: CMTO e
Figure 4-12 Ensure Configuration name - CMTO0
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In ‘Config_CMTO0’, configure CMTO as shown in Figure 4-13. This timer is configured to generate a high
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

Components 2 5 4 3 v Configure
L Count clock setting
type filter text |®pcike | O PCLK/32 O PCLK/128 O PCLK/512
~ & Startup ~ i Compare match setting
v (= Generic Interval value |1 Ims VI (Actual value: 1)
w r_bsp
« & Drivers Register value (CMCOR) | 7499
v @& Timers [~] Compare match interrupt (CMIO)
@ Config_ CMT0 Priority [Levei 10 1

Figure 4-13 Config_CMTO setting
CMT1 will be used as an interval timer for generation of accurate delays. CMT1 and CMT2 will be used as

timers in de-bouncing of switch interrupts.
Select ‘Compare Match Timer’ as shown in Figure 4-14 below then click ‘Next'.

| Software Component Selection

Select component from those available in list

Category IDrivers Iv
Function | All w
| Filter | |
| Components Short Name Type Version |
8 8-Bit Timer Code Generator 1.9.0
| | B Clock Frequency Accuracy Measurem... Code Generator 1,100
: # Clock Synchronous Control Module f..  r_flash_spi Firmware Integ.. 3.03
B8 Comparator Code Generator 1.8.1
| 8 Compare Match Timer Code Generator 220 |
B Complementary PWM Mode Timer Code Generator 1100
# Continuous Scan Mode 512AD Code Generator 1,120
## CRC Calculator Code Generator  1.10.0
B8 D/A Converter Code Generator  1.10.0
i Data Operation Circuit Code Generator  1.710.0
8 Data Transfer Controller Code Generator 1,100
| #8 Dead-time Compensation Counter Code Generator 1100 ¥
| Show only latest version
Hide items that have duplicated functionality
Description
Thls soﬁwa re cumponer;i prm;l_d-es confi-g ur;fibns-%o; 1 Eb IUiEbIE Ei-l-'ner wnh mo"d.l..l-l_e- ~
CMT/CMTW and can generate interrupts at set intervals.
Download the latest FIT drivers and middleware
Configure general settings...
.'_> < Back Next > I [ Finish | Cancel

Figure 4-14 Select Compare Match Timer
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In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMT1’ as shown in Figure 4-15
below.

&) Mew Component O X

Add new configuration for selected component tB

Compare Match Timer

Configuration name: c onfig_CMTWO

Resource:

2 < Back Next » Cancel
' Figure 4-15 Select Resource - CMT1

Ensure that the ‘Configuration name’ updates to ‘Config_ CMT1’ as shown in Figure 4-16 below then click
‘Finish’.

&) New Component O X ‘
Add new configuration for selected component tB
Compare Match Timer
Configuration name: ICcmf ig_CMT1 I
Resource: CMT1 v
@ < Back Next > Cancel

Figure 4-16 Ensure Configuration name - CMT1
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In ‘Config_CMT1’, configure CMT1 as shown in Figure 4-17. This timer is configured to generate a high
priority interrupt every 20ms. We will use this interrupt later in the tutorial to provide an API for generating
high accuracy delays required in our application.

Components iz i3 - 4 3¥ * Configure
o . Count clock setting
type filter text O PCLK/B ® PCLK/32 O PCLK/128 O PCLK/512
v = Startup Ll Compare match setting
v & Generic Interval value I 20 I I ms vI {Actual value: 20)
w r_bsp -
« @ Drivers Register value (CMCOR) 3?_499
v & Timers Compare match interrupt (CMI1)
« Config_CMTO Priority ILE‘UE| 10 VI
« Config_CMT1

Figure 4-17 Config_CMT1 setting

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’

Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT2’ as shown in Figure 4-18 below.

& New Component O X |

Add new configuration for selected component t{j

Compare Match Timer

Configuration name: -Confiq _CMTWO

Resource:
@ < Back Next > Cancel
' Figure 4-18 Select Resource — CMT2
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Ensure that the ‘Configuration name’ updates to ‘Config_ CMT2’ as shown in Figure 4-19 below then click
‘Finish’.

&) New Component O X ‘
Add new configuration for selected component tl:!
Compare Match Timer
Configuration name: I-Config_CMT2 I
Resource: CMT2 -

Figure 4-19 Ensure Configuration name — CMT2

Navigate to the ‘Config_ CMT2’ and configure CMT2 as shown in Figure 4-20. This timer is configured to

generate a high priority interrupt after 200ms. This timer is used as our short switch de-bounce timer later in
this tutorial.

Components O] -+ 3 v Configure
o . Count clock setting
type filter text O PCLK/B O PCLK/32 O PCLK/128 ® PCLK/512
« & Startup A Compare match setting
v 2 Generic Interval value IZQ{) vl Actual value: 200.00
w r_bsp T
« @& Drivers Register value (CMCOR) 2343?
w = Timers Compare match interrupt (CMI2)
& Config_CMTO Priority ILeueI 10 VI
& Config_CMT1
@ Config_CMT2
Figure 4-20 Config_CMT2 setting
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4.6.3 Interrupt Controller

Referring to the RSK schematic, SW1 is connected to IRQ9(P91) and SW2 is connected to IRQ10(P92).
SW3 is connected to ADTRGON (P07). This tutorial uses ADTRGOnN, which will be configured later in section

46.7.

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’
Select ‘Interrupt Controller’ as shown in Figure 4-21 then click ‘Next'.

ﬁ New Component O

Software Component Selection

Select component from those available in list

X

Category IDtivets

Function Al

Filter |

Components

B DMA Controller

## Event Link Controller

B Group Scan Mode S12AD
B8 12C Master Mode

B8 12C Slave Mode

Short Name Type
Code Generator  1.7.0
Code Generator  1.8.0
Code Generator 1.11.0
Code Generator  1.11.0
Code Generator  1.10.0

ersion *

I & Interrupt Controller Code Generator 2.20

B Low Power Consumption Code Generator 220
B Normal Mode Timer Code Generator  1.11.0
# Phase Counting Mode Timer Code Generator  2.3.0
B Ports Code Generator 230
B PWM Moade Timer Code Generator  1.11.0

| B Real Time Clock Code Generator  1.7.0

Show only latest version

Hide iterns that have duplicated functionality

Description
Interrupt Controller configures the interrupt requests generated by ICU: Software interrupt,
MNMI pin interrupt and IRQ External pin interrupts.

Download the latest FIT drivers and middleware

Configure general settings...

@ < Back | Next > | [ Finish | Cancel

Figure 4-21 Select Interrupt Controller

W
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In ‘Add new configuration for selected component’ dialog -> Resource, select ‘ICU’ as shown in Figure 4-22
below then click ‘Finish’.

&) New Component O X |

Add new configuration for selected component t}j

Interrupt Controller

Configuration name: Itcnfig_lCU I

Resource: Icu w

Figure 4-22 Select Resource - ICU
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Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-23

below.

13

~ & Generic

& rbsp
~ & Drivers
v & Interrupt
@ Config_iCU
~ & Timers
& Config_CMTO

@ Config_CMT1
@ Config_CMT2

Software component configuration
Components 2 (% 5 3 v Configure

Software interrupt setting
[ software interrupt
[] software interrupt 2

NMI pin interrupt setting
[T MM pin interrupt [

IRQO setting
[Jirao

IRQ1 setting

Oirat

IRQ2 setting
CJraz

IRQ3 setting
Ira3

IRQ4 setting
[irRQ4

IRQ5 setting
[Jiras

IRQE setting
CIIrRas

IRQ7 setting
rar

IRQ8 setting
[iras

IRQ9 setting

Elree

IRQ10 setting

IRQ11 setting
CJirai

IRQ12 setting

Cirai2 De

IRQ13 setting
JIra13 [

IRQ14 setting
Clira14

IRQ15 setting
Oirats

Level 15 (highest}

Falling edge

Low level

Level 15 (highest)

Low level

F ty Lewel 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest}

Low level

F v Level 15 (highest)

Low level

Pr Level 15 (highest}

Low level

F ty | Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Priorty [evel 95 (hghest)

Low level

Pricrity [Level 15 (highest)

il

Generate Code Generate Rep

! Mo filter

No filter

No filter

i No filter

i No filter

! No filter

! No filter

ta No filter

| No filter

tal Mo filter

Detection type] Falling edge ~ | Digital filter |No filter

Priority |Level 15 {highest)

~

RQ10 Detection typef Falling edge ~ | Digital filter |No filter

Pricrity | Level 15 (highest)

v

No filter

No filter

Jita Mo filter

No filter

tal No filter

Figure 4-23 Config_ICU setting
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4.6.4 Ports

Referring to the RSK schematic, LEDO is connected to P17, LED1 is connected to PF5, LED2 is connected to
P04 and LED3 is connected to P06. PJ3 is used as one of the LCD control lines, together with PLO, P71 and

P72.

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’

Select ‘Ports’ as shown in Figure 4-24 then click ‘Next'.

Show only latest version
Hide items that have duplicated functionality

Download the latest FIT drivers and middleware

Configure general settings...

'9 < Back I MNext > I[

Finish

Figure 4-24 Select Ports

&) New Component O > ‘
Software Component Selection t&
Select component from those available in list
Category I Drrivers Iv
Function  All ~
Filter | |
Components ' Short Name Type Version ~
# Low Power Consumption Code Generator 2.2.0
B Normal Mode Timer Code Generator  1.11.0
8 Phase Counting Mode Timer Code Generator  2.3.0
i Ports Code Generator _2.3.0
E PWM Mode Timer Code Generator  1.11.0
B Real Time Clock Code Generator  1.7.0
£ Remote Control Signal Receiver Code Generator  1.1.0
B SCI/SCIF Asynchronous Mode Code Generator  1.11.0
#8 SCI/SCIF Clock Synchronous Mode Code Generator 1.11.0
B Single Scan Mode S12AD Code Generator 2.4.0
B Smart Card Interface Mode Code Generator  1.11.0
| B 5Pl Clock Synchronous Mode (3-wire ... Code Generator 1110 ¥ |

Description
This software component provides configurations for General Purpose Input/Qutput. N
Common features such as reading, writing, and setting the direction of ports and pins can be
configured. Enabling features such as open-drain outputs and internal pull-ups are also |

Cancel
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In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-25
below then click ‘Finish’.

&) New Component O * ‘
Add new configuration for selected component t{:i
Ports

Configuration name: |[Config_PORT

Resource: PORT »

@ < Back Next > Cancel

Figure 4-25 Select Resource — PORT

Tick the tickboxes for ‘PORTO’, ‘PORT1’, ‘PORT7’, ‘PORTF’, ‘PORTJ’ and ‘PORTL’ as shown in Figure 4-26

below.
Compon... i w3 - 4 I Configure
- & Port selection PORTO PORT1 PORT? PORTF PORT] PORTL
type filter text
w = Startup
v i Glnsic [/] PORTO PORT1
& r_bsp
o RT RT
v & Dnvers DPD E DPG .
w & |Intermupt ] PORT4 []1PORTS
& Config_ICU
~ & /O Ports [1PORTE PORT7
& Config_PORT
I Tl [JPORTS [1PoRTS
& Config_CMTOD
E RT, RT|
& Config_CMT1 L] PORTA [ircrrs
s Config_CMTE D PORTC D PORTD
C1PORTE PORTF
C1PORTH PORT)
[1PORTK PORTL
C1PORTN

Figure 4-26 Select Port selection
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Navigate through each of the 'PORTX' tabs, configuring these four I/O lines and LCD control lines as shown in
Figure 4-27, Figure 4-28, Figure 4-29, Figure 4-30, Figure 4-31 and Figure 4-32 below. Tick the tickboxes
for ‘Out’ and tick ‘Output 1’ the tickboxes except for P72 under the ‘PORT7’ tab. Start with the 'PORTO' tab.

A

Components 2 e

H v

L

type filter text

Select ‘PORT1’ tab.

v =

g

& Drivers

v

Components

Startup
& Generic
@ rbsp

& Interrupt
& Config_ICU
& 1/0 Ports
« Config PORT
& Timers
@ Config_CMTO
@ Config_CMT1
@ Config_CMT2

2 o 1%

type filter text

-

& Dnivers

w

= Startup

& Genernic
@ rbsp

& Interrupt
@ Config_ICU
& 1/0 Ports
« Config_PORT
& Timers
@ Config_CMTO
@ Config_CMT1
@ Config_CMT2

Configure

Port selectio PORTI PORT? PORTF PORT) PORTL

] Apply to all

Unused GPIO

POO
® Unused GPIO

PO1
(@ Unused GPIO

PO2
@ Unused GPIO

PO3
(® Unused GPIC

P04
() Unused GPIO

POS
(@ Unused GPIO

P06
O Unused GPIO

PO7
(@ Unused GPIO

O
s

Cin

Oin

Oln

Oln

Clin

Oout [Jrull-up
Oout []Pull-up
O Out

[ Pull-up

Oout [pull-up

Oou [Jrull-up
Pull-up

@ out

Oout [JPull-up

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

Figure 4-27 Select PORTO tab

Configure

Port selection PORTOD T}' PORTF

] Apply to all

Unused GPIO

P2
(® Unused GPIO

P13
(@) Unused GPIO

P14
(@ Unused GPIO

P15
(®) Unused GPIO

P16
(® Unused GPIO

P7
) Unused GPIO

Oln

Oin

Oin

Oln

Out Pull-up

[ rull-up

I Puli-up

] Pull-up

[ Pull-up

CIPull-up

PORT) PORTL

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

Oln Pull-up | CMOS output

Figure 4-28 Select PORT1 tab

(4

Uutput

Output 1

Normal drive output

Normal drive output

Normal drive output

Output 1 |Normal drive output

Output 1

[ Output 1

Output 1

Qutput 1

Qutput 1

MNormal drive output

Normal drive output

Normal drive output

Normal drive output

Normal dnve output

Normal drive output

[l output 1 |Normal drive output

o~
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Select ‘PORT7’ tab.

Components 2 e % - ¥ 3 Configure (1l ~
e Port selection  PORTO PORT1 PORTF PORT) PORTL
type filter text
v & Startup
Apply to all
v & Generic CJApply
@ rbsp Unused GPIO In Out Pull-up |CMOS output Qutput 1 Normal drive output
~ & Drivers
~ & Interrupt P70
@ Config_ICU @®Unused GPIO Oin O0ut [JPull-up | CMOS output v Output 1 Normal drive output
~ & 1/0 Ports
« Config_PORT : P71
v (& Timers OUnused GRIC O In Pull-up  |CMOS output v Output 1 | Normal drive output ~
@ Config_CMTO
@ Config_CMT1 P72
@ Config CMT2 O Unused GPIO. OIn Pull-up  |CMOS output ~| [Joutput1  Normal drive output ~
P73
@Unused GPIO Oin O0Out [JPull-up | CMOS output w Output 1 Normal drive output
P74
@®Unused GPIO Oin O Out [JPull-up | CMOS output - Output 1 Normal drive output ~
P75
@ Unused GPI0. O'in O0ut [JPull-up  |CMOS output ~ Output 1 Normal drive output
P76
@Unused GPIO Oin O 0Out [JPull-up |CMOS output v Output 1 Normal drive output +
PTT
@ Unused GPIO Clin O 0wt [JPull-up | CMOS output ~ Output 1 Mormal drive output

Figure 4-29 Select PORT7 tab

Select ‘PORTF’ tab.

Components 25 ed % ) ¥ 3 v Configure o ~
bl Port selection PORTO PORT1 PORT? PORT) PORTL
type filter text
v (& Startup
il Caiaiis [JApply to all
@ rbsp Unused GPIO In Out Pull-up |CMOS Gutput OQutput 1 | Narmal drive output
~ & Drivers
w & Interrupt PF5
@ Config_ICU O Unused GPIO O In Pull-up  |CMOS output v/l “loutput 1 | Normal drive output ~
v & /O Ports [
| « Config PORT : PF6
w = Timers | @ Unused GPIO Olin O Out I:‘Puli—up CMOS output ~ Output 1 Normal drive output  ~
@ Config_CMTO
& Config_CMT1 PF7
@ Config CMT2 @Unused GPIO Oin O out [JPull-up |CMOS output ~ Output T Normal drive output
Figure 4-30 Select PORTF tab
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Select ‘PORTJ' tab.
Components 2 e % - ¥ 3 Configure (1l ~
= Port selection PORT0 PORT1 PORT7 PORTF PORTL
type filter text
v & Startup
Apply to all
v & Generic CJApplyto 2
@ rbsp Unused GPIO In Out Pull-up |CMOS output Output 1
~ (& Drivers
v & Interrupt PN
@ Config_ICU @Unused GPI0 Oin O Out [JPull-up  |CMOS output v Output 1 Normal drive output
~ & 1/0 Ports
« Config_PORT . P13
~ & Timers O Unused GPIO D in Pull-up  |CMOS output ~|| ] Output 1 | Normal drive output ~
@ Config_CMTO
@ Config_CMT1 P}
@ Config CMT2 @Unused GPIC Oin OOut [JPull-up  |CMOS output ~ Output T Normal drive output v
P15
@Unused GPIO Oin O0Out [JPull-up | CMOS output w Output 1 Normal drive output
Pl6
@®Unused GPIO Oin OOut [JPull-up | CMOS output ~ Output 1
PI7
®) Uni n -up output w Jutput 1
@®@Unused GPIO Oin O out [JPull CMOS 0
Figure 4-31 Select PORTJ tab
Select ‘PORTL tab.
Components 2sed 1% 5 3 3 v Configure o
b Port selection PORTO PORT1 PORT7 PORTF PORTI
type filter text
v & Startup
Apply to all
v & Generic Dlapplytoa
@ rbsp Unused GPIO In Out Pull-up | EMOS output Output 1 | Normal drive output
w & Drivers
v & Interrupt PLO
& Config_ICU OuUnused P10 Oln Pull-up | CMOS output “/| Floutput 1 | Normal drive output ~
v & /0 Ports [
« Config_PORT . PLY
+ & Timers @®Unused GPIO Oin O 0Out [JPull-up |CMOS output ~ Output 1 Normal drive output ~
@ Config_CMTO
@ Config_CMT1
@ Config_CMT2
Figure 4-32 Select PORTL tab
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4.6.5 SCI/SCIF Asynchronous Mode

In the RSKRX660, SCI10 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as shown
in the schematic.

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select

‘SCI/SCIF Asynchronous Mode’ as shown in Figure 4-33 then click ‘Next'.

Software Component Selection

Select component from those available in list

Category IDtivets

Show only latest version
Hide iterns that have duplicated functionality

Description

| Function | All ~
Filter | |
Components Short Name Type Version *
B PWM Mode Timer Code Generator  1.11.0
B8 Real Time Clock Code Generator  1.7.0
B8 Remote Control Signal Receiver Code Generator  1.1.0
| # sciysaiF Asynchronous Mode Code Generator 1.110 |
B SCI/SCIF Clock Synchronous Mode Code Generator  1.11.0
# Single Scan Mode 512AD Code Generator 2.4.0
## Smart Card Interface Mode Code Generator 1.11.0
8 5P| Clock Synchronous Mode (3-wire ... Code Generator  1.11.0
# SPI Operation Mode (4-wire method) Code Generator  1.9.0
8 Voltage Detection Circuit Code Generator  1.10.0
8 Watchdog Timer Code Generator 1,100

This software companent provides configurations for SCI(SCIF) single{multi-processor)

asynchronous mode.

Download the latest FIT drivers and middleware

Configure general settings...

@ < Back I Next >

Finish |

Cancel

Figure 4-33 Select SCI/SCIF Asynchronous Mode
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In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as

shown in Figure 4-34 below.

{8} New Component O > |
Add new configuration for selected component tH
SCI/SCIF Asynchronous Mode
Configuration name: |Config_SCI0
Work mode: Transmission W
Hoadaoes Transm}ss:on
Becention
Transmission/Reception
Multi-processor Transmission
Multi-processor Reception
Multi-processor Transmission/Reception '
|

Figure 4-34 Select Work mode — Transmission/Reception

In ‘Resource’, select ‘SCI10’ as shown in Figure 4-35 below.

ﬁ Mew Component

Configuration name:
Work mode:

Resource:

Add new configuration for selected component {:H

SCI/SCIF Asynchronous Mode

Config_SCI0

Transmission/Reception v

SCI0 i
sCio

scn

sCI2

sCI3 |
SCl4
5CI5
sCle
SCI7
sCla

a0

sCin
SCl2

Figure 4-35 Select Resource — SCI10
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Ensure that the ‘Configuration name’ updates to ‘Config_SCI10’ as shown in Figure 4-36 below then click
‘Finish’.

&) New Component O *
Add new configuration for selected component tb
SCI/SCIF Asynchronous Mode
Configuration name: ICc:-nhq SCI0 I
Work mode: Transmission/Reception ~
Resource: SCIo w

Figure 4-36 Ensure Configuration name - Config_SCI10
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Configure SCI10 as shown in Figure 4-37. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on
RXD1 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.

Components @l . - 4 3p v Configure €
e FIFO mode setting
| | (® Non-FIFO mode (O FIFO mode
v & Startup Start bit edge detection setting
v & Generic (O Low level on RXD10 pin I @ Falling edge on RXD10 pin I
@ rbsp _
v @ Drivers I:_}ata length setting
v & Interrupt ()9 bits @) 8 bits (O 7 bits
@ Config_ICU Parity setting
v & /O Ports @ None O Even O 0dd
@ Config_PORT ) _
+ @ Communications Stopbil length sething
« Config_SCI10 @ 1 bit Q2 bits
v Tf"‘e“ Transfer direction setting
. Config_CMTO @ LSB-first (O MSB-first
@ Config_CMT1
& Config_CMT2 D:ata inversion setting
(® Normal O Inverted
Instant transmission setting
] Enable instant transmission
Transmitter output setting
® Normal O Inverted
Receiver input setting
(@ Normal O Inverted
Transfer rate setting
Transfer clock Internal clock v
Base clock 16 cycles for 1-bit period b
Bit rate I 19200 I Vi (bps) (Actual value: 19230.769, Error: (.16%)
[] Enable modulation duty correction
SCK10 pin function SCK10 is not used ™
Transfer timing adjustment setting
[C) Adjust transmit signal transition Does not change the waveform
Dndjust receive data sampling 3 clocks later than default point
Noise filter setting
[CJEnable noise filter
i Clock signal divided by 1 120000000 H
Hardware flow control setting
@ None QO crs10# ORTS10%
F ctive trigg 15
FIFO data setting
Tra: FIFC d 19 0
F & FIFC data trigg 8
Data match detection setting
[[]Enable data match detection
] fata 0x00
Data handling setting
Transmit data handling Data handled in interrupt service routine >
Receive data handling Data handled in interrupt service routine v
Interrupt setting
TXI0 priority Level 15 (highest) v
RX110 priority Level 15 (highest) v
[“] Enable reception error interrupt (ERI10)
TEI0, ERI10 priority (Group ALD) Level 15 (highest) ~
Receive data ready interrupt Receive data full interrupt (RXI)
Callback function setting
[ Transmission end Reception end Reception error
Figure 4-37 Config_SCI10 setting
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4.6.6

SPI Clock Synchronous Mode

In the RSKRX660, SCI6 is used as an SPI master for the Pmod LCD on the PMOD1 connector as shown in

the schematic. Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select

‘Drivers’. Select ‘SPI Clock Synchronous Mode’ as shown in Figure 4-38 then click ‘Next'.

ﬁ New Component

Software Component Selection

Select component from those available in list

O X

Show only latest version
Hide items that have duplicated
Description

Master transmit.

functionality

This component provides clock synchronous operation of RSPI or SCI (Simple SP1 bus). It
includes 4 transfer modes: Slave transmit/receive, Slave transmit, Master transmit/receive and

Category I Drivers I W
Function |All ~
Filter | |

Components Short Name Type Version * |

B PWM Mode Timer Code Generator  1.11.0

## Real Time Clock Code Generator  1.7.0

B Remote Control Signal Receiver Code Generator 1.1.0

B8 SCI/SCIF Asynchronous Made Code Generator  1.11.0

B8 SCI/SCIF Clock Synchronous Mode Code Generator  1.11.0

B Single Scan Mode S12AD Code Generator 24.0

8 Smart Card Interface Mode Code Generator 1,110
| & SPI Clock Synchronous Mode (3-wire .. Code Generator 1110 |

## 5Pl Operation Mode (4-wire method) Code Generator 190

B Voltage Detection Circuit Code Generator  1.10.0

B Watchdog Timer Code Generator 1100

Download the latest FIT dnvers and middieware

Configure general settings...

(&) < Back

I Next > I[

Finish |

Cancel

Figure 4-38 Select SPI Clock Synchronous Mode
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In ‘Add new configuration for selected component’ dialog -> Operation, select ‘Master transmit only’ as shown
in Figure 4-39 below.

&) New Component O * |

Add new configuration for selected component tB

SPI Clock Synchronous Maode (3-wire method)

Configuration name: | Config_RSPID

Operation: Slave transmit/receive v

Slave transmit/receive
Slave transmit only
Slave receive only
Master transmit/receive

Resource:

Figure 4-39 Select Operation — Master transmit only

In ‘Resource’, select ‘SCI6’ as shown in Figure 4-40 below.

&) New Component O d

Add new configuration for selected component tH

SPI Clock Synchronous Mode (3-wire method)

Configuration name: | Config_RSPIO

Operation: Master transmit only w

Resource: RSPIO w

RSPIO
SCI0
scn
SCI2
s5C3
SCH

S —

SCi8
SCI9
SCIo
SCin
SC2

Figure 4-40 Select Resource — SCI6
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Ensure that the ‘Configuration name’ updates to ‘Config_SCI6’ as shown in Figure 4-41 below then click
‘Finish’.

& New Component O X ‘

Add new configuration for selected component tB

SPI Clock Synchronous Mode (3-wire method)

Configuration name: ICanig_SCiE I
Operation: Master transmit only w
Resource: SCl6 v

Figure 4-41 Ensure Configuration name - Config_SCI6

Configure SCI6 as shown in Figure 4-42. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’
is set to 6000 kbps. All other settings remain at their defaults.

Components e . - 4 I v Configure
L Transfer direction setting
fypefittertet | OLse-first ® MSB-first
v = Startup 0 )
il i _ata inversion setting _
& rbsp (® Normal () Inverted
v & Dnvers )
Transfer speed setting
v & Interrupt
& Config_ICU Transfer clock Internal clock (SCK6 pin functions as clock output pin) ~
v & /O Ports y
: Bit rate 15000 kbps) (Actual value: 15000, Error: 0%)
@ Config PORT o I | e it e
« = Communications L_| Enable modulation duty comrection
u-_ Ccnffg_SCHO Clock setting
&« Config_SCI6 i
v & Timers || Enable clock delay [JEnable clock polarity inversion

& Config_CMTO
& Config_CMT1
@ Config_CMT2 Transmit data handling Data handled in interrupt senvice routine b

Data handling setting

Interrupt setting
TXI6 priority Level 15 (highest) W
TEI6 priority (Group BLO) Level 15 (highest) =

Callback function setting

[+/] Transmission end

Figure 4-42 Config_SCI6 setting
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4.6.7 Single Scan Mode S12AD

We will be using the S12AD in Single Scan Mode on the ANOOO input, which is connected to the RV1
potentiometer output on the RSK. The conversion start trigger will be via the pin connected to SW3. Click the

‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘Single
Scan Mode S12AD’ as shown in Figure 4-43 then click ‘Next'.

}a o X |
Software Component Selection tH
Select component from those available in list
|
| Category IDrivers Iv
Function  All ~
| Fiter |
| | Components . Short Name Type Version
| B PWM Mode Timer Code Generator 1,110
B Real Time Clock Code Generator 1.7.0
B Remote Control Signal Receiver Code Generator 1.1.0
| | # SCI/SCIF Asynchronous Mode Code Generator  1.11.0
I ## SCI/SCIF Clock Synchronous Mode Code Generator  1.11.0
| Single Scan Mode S12AD Code Generator 240 |
| | # Smart Card Interface Mode Code Generator  1.11.0
B8 SPI Clock Synchronous Mode (3-wire ... Code Generator 1.11.0
B SPI Operation Mode (4-wire method) Code Generator  1.9.0
| |8 Voltage Detection Circuit Code Generator  1.10.0
B Watchdog Timer Code Generator  1.10.0
W

Show only latest version
Hide items that have duplicated functionality

Description

| This software component provides single scan mode configurations for 12-Bit A/D Converter
which the analog inputs arbitranly selected are converted for only once in ascending channel
order. |

Download the latest FIT dnvers and middleware

Configure general settings...

(&) < Back I Next > I[ Finish I Cancel

Figure 4-43 Select Single Scan Mode S12AD
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Ensure that the 'Configuration name' is'Config_S12AD0' as shown in Figure 4-44 below then click ‘Finish’.

&) New Component O et ‘
Add new configuration for selected component tb‘
Single Scan Mode S12AD
Configuration name: Itonhg_S‘IEADD I

Resource: S12AD0

Figure 4-44 Ensure Configuration name - S12AD0
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Configure S12AD0 as shown in Figure 4-45 and Figure 4-47 and Figure 4-46. Ensure the ‘Analog input
channel tick box for ANOOO is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’.
All other settings remain at their defaults.

Components @il - + 3 ¥ Configure
&=
= ~ Basic setting
type filter text
Lail < Analog input mode setting
v M Startup [ Double trigger mode
v = Generic
@ rbsp Analog input channel setting
v @& Drivers EANDOD O aNoo1 [ anooz [Janoo3 ] ANDO4
v & Interrupt [ Ano0S ] ANOOS [ anoo7 []Aanooa [ AnD09
@ Config_ICU Canoo CJaNo11 [Jano12 [CJano13 ] AND14
~ & A/D Converter ] AND1S [JAND16 ] AND17 CANo18 ] AND19
@ Config_S12AD0 | ] AND20 ] AND21 ] ANp22 C]ANo23
~ & 1/O P
/0 or‘l?s O Temperature sensor output [ Internal reference voltage
& Config_PORT
v & Communications Conversion start trigger setting
& Config_SCI10 - :
. % Start trigger source A/D conversion start trigger pin o
& Config_SCI6 oot I et |
v & Timers Interrupt setting
& Config_CMTO
& Config CMT1 Enable AD conversion end interrupt (S12AD1)  Priority  Level 15 (highest) ~
@ Config_CMT2
= Advance setting
Add/Average AD value setting
[ AnooOD 01
Reference voltage setting
@ AVCCO/AVSSO () VREFHO/VREFLO
Self diagnosis setting
Mode Unused e
Disconnection detection assist setting
Charge setting Unused v
Data registers setting
Data placement Right-alignment ~
Automatic clearing Disable automatic clearing v
Addition/Average mode select Addition mode w
Addition count 1-time i
Window function setting
(® Disable () Enable
Window A/B operation setting
] Enable comparison window A [CJEnable comparison window B
1 Wi ow A comparison condition 1y B companson tion mr
Figure 4-45 Config_S12AD0 setting (1)
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A/D comparison A setting

fata O paris 0
fata 11 SMParisor 0
Use comparator for ANOOD Reference data 0 > A/D-converted value

Refere 0 > A/D-converted value

Reference data 0 > A/D-converted value

Reference data 0 > A/D-converted value

Use comparator for ANDO4 Reference data 0 > A/D-converted value
Use co r for ANODS Reference data 0 = A/

Use comparator for ANQDG Reference data 0 > A/D-converted v
Use comparator for ANOO7 Reference data 0 > A/D-comnverted value
Use comparator for ANDOS Reference data 0 > A/D-converted value
Use comparator for ANOD9 Reference data 0 > A/D-converted

N

Use comparator for A Reference data 0 = A/D-converted

Use comparator for A Reference data 0 > A/D-converted value

Use comparator for ANC Reference data 0 > A/D-converted value

Use comparator for ANO Reference data 0 > A/D-converted value

parator for AND14

Reference data 0 > A/ verted value

Use comparator for ANO15 Reference data 0 > A/D-converted value

rator for A Reference ¢ > A/D-converted

Use comp

e

017 Reference data /D-converted value

Use comparator for A

Use comparator for ANO18 Reference data 0 > A/D-converted value

S|

Use comparator for A Reference data 0 > A/D-converted value

Use comparator for ANO20 Reference data 0 > A/

D-converted value

Use comparator for AND21 Reference data 0 > A/D-converted value

Use comparator for ANC Reference data 0 > A/D-converted value

rator for A

Reference data 0 > A/D-co

1 value

Use comparator for Temperature sensor output Reference data 0 > A/D-converted value

comparator for Internal reference voltage Reference data 0 > A/D-converted

A/D comparison B setting

4 0
la
lata paris 0

panson B anr Unused

Reference data 0 > A/D-converted value

Figure 4-46 Config_S12ADO0 setting (2)
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Input sampling time setting

ANO0O/Self-diagnosis (045

ADSTO output setting
[ Enable ADSTO pin output

Event link control setting

ELC scan end event generation condition

Interrupt setting

al conversion time: 1,05

(us)

On completion of all scans

(A

ctual value: 0.450)

Figure 4-47 Config_S12AD0 setting (3)
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4.7 The ‘Pins’ tabbed page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the
pins can be changed using the Pins page.

Pin configuration

Hardware Resource ES L
[ & A .-\
o Digital power supply
@ Clock

& Clock frequency accuracy measurement circuit
& Operating mode control
% System control
¥ On-chip emulator
of Buses
® Interrupt
v [ Multi-function timer pulse unit 3
w MTUO
= MTUT
w MTUZ
w MTU3
w MTU4
w MTUS
w MTUG
w MTU7?
w MTUS
L Port output enable 3
~ U4 B-bit timer
w TMRO 2

Pin Function Pin Number

Overview | Board | Clocks | System Componenlntenupts
Figure 4-48 The ‘Pins’ tabbed page

4.71 Change pin assignment of a software component

To change the pin assignment of a software component in the Pin Function list, click 6% to change view to
show by Software Components.

Pin configuration

Hardware Resource no= :‘;I %
n .
|

Figtjre 4-49 Change view to show by Hardware Resource
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Select the Config_ICU of Software Components. In the Pin Function list -> Assignment column, change the
pin assignment IRQ9 to P91, IRQ10 to P92. Ensure the ‘Enable’ tick box of IRQ9 and IRQ10 are checked, as

shown in Figure 4-50.

Software Components ¥ = 1% &% Pin Function 2| H| 5| 2ed
Type filter text |r',-'ne filter text (* = any stnng, ? = any character) All ~
& Compare Match Timer Function Assignment PinNumber Direction Remarks

= Config CMTO [J IrRQo # Not assigned # Mot assigne None
= Config_CMT1 O mwa # Not assigned # Mot assigne None
= Config CMT2 O ka2 # Not assigned # Mot assigne None
v & rbsp [0 IraQ3 # Not assigned # Not assigne None
= r_bsp O ko4 # Not assigned # Mot assigne None
v i Irlteuupt Controller O mras # Not assigned # Mot assigne None
& ConfigICU 0 a6 # Not assigned # Mot assigne None
v & Ports O Ira7 # Not assigned # Mot assigne None
@' Config_PORT [ IrRQs # Nat assigned # Not assigne None
» & SCI/SCIF Asynchronous Mode IRQ9 # P91/TRDATA4/A17/SCKT/IRQY 7129 I
@ Config_5CI10 IRQ10 7 P92/TRDATAS/A18/POE4#/RXDT/SMISO74 7 128 I
~ & SPI Clock Synchronous Mode (3-wire method) O kan # Not assigned # Not assigne None
@ Config_SCl6 O IrQ12 # Not assigned # Mot assigne None
~ & Single Scan Mode S12AD O Rrai3 # Not assigned # Not assigne None
& Config S12AD0 O mra4 # Not assigned # Mot assigne None
1 rQis # Not assigned # Not assigne None
[0 Nmi # Not assigned # Mot assigne None

Pin Function Pin Number

Figure 4-50 Configure pin assignment - Config_ICU

Select the Config_SCI10 of Software Components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD10 and TXD10 are checked and Assignment column of RXD10 is P86 and TXD10 is

P87 as shown in Figure 4-51.

w X Single Scan Mode S12AD
& Config_S12AD0

Software Components [+ ~ % & Pin Function 2B s
Type filter text | |?3‘|1|= filter text (* = any string, 7 = any character) All o
~ & Compare Match Timer Enabl.. Function Assignment Pin Number Direction Remarks
= Config CMTO [ crsio# # Not assigned # Mot assigne None
= Config CMT1 RTS10:# # Not assigned # Not assigne None
= Config_CMT2 RXD10 I-" P%,-’MTIOC4D!SMISO1U{SS(L10,-’RXDlﬂﬁ*-‘ 41 |

v & rbsp SCK10 # Not assigned # Not assigne None
= rbsp [] D10 |7 P87/MTIOCAC/SMOSI10/SSDA10/TXD10/1]# 39 o

« & Interrupt Controller
@ Config_ICU

v & Ports
@ Config_ PORT

~ & SCI/SCIF Asynchronous Mode
& Config_SCI10

+ & SPI Clock Synchronous Mode (3-wire method)
@ Config_5CI6

Pin Function Pin Number

Figure 4-51 Configure pin assignment - Config_SCI10
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Select the Config_SCI6 of Software Components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK6 and SMOSI6 are checked and Assignment column of SCK6 is P02, SMOSI6 is P00

as shown in Figure 4-52.

Software Components

4 = 1% &% Pin Function

2 HE| L] s

|Typ1= filter text

| |£.rut’ filter text (* = any string, ? = any character)

All

« & Compare Match Timer
w Config_CMTOD
= Config_CMT1
w Config_CMT2
~ X rbsp
w r_bsp
~ & Interrupt Controller
& Config_ICU
v & Ports
& Config PORT
v /& SCI/SCIF Asynchronous Mode
& Config_SCI0

@ Config_SCI6

| 2 SPI Clock Synchronous Mode (3-wire method)

« X Single Scan Mode 512AD
@ Config_S12AD0

Direction

10

10

Enabl.. Function Assignment Pin Number
SCK6 |7 Po2/TMCI1/SCK6/IRQ10 | B
O smis06 7 Mot assigned # Not assigne None
smMosie | POO/TMRIO/TXD6/SMOSIG/SSDAG/IRQS |~ 8
[] sse# # Not assigned 7 Not assigne None

e

Remarks

Pin Function Pin Number

Figure 4-52 Configure pin assignment - Config_SCI6

Select the Config_S12AD0 of software components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of ADTRGO#, ANOOO are checked and Assignment column of ANOOO is P40, ADTRGO# is

P07 as shown in Figure 4-53.

Software Components 4~ 1% & Pin Function 2B R ea
Type filter text | |1‘_,pr filter text (* = any string, ? = any character) All b
» i Compare Match Timer Enabl.. Function Assignment Pin Number Direction Remarks

= Config CMTO [ ADSTO 7 Not assigned 7 Not assigne None
w Config_CMT1 ADTRGO# |7 PO7/IRQ15/ADTRGO# 144 [
= Config CMT2 ANDOO # P40/IRQ8/ANDOD b 141 [
v X bsp [] ANOD1 # Mot assigned # Mot assigne None
~ rbsp [0 ANpO2 # Mot assigned # Mot assigne None
v& Interrupt Controller [0 ANCO3 # Not assigned # Not assigne None
& Config_ICU [0 AN0O4 r Not assigned # Mot assigne None
v& P?rts [0 ANDOS # Not assigned # Not assigne None
& Config_PORT ] ANOO6 # Not assigned # Not assigne None
v & 5_C|4’SC'F Asynchronous Mode [0 ANoO7 # Not assigned # Not assigne None
& Config 5CI0 ] ancos # Mot assigned # Mot assigne None
v & SPI Clock Synchronous Mode (3-wire method) [J ANoo9 # Not assigned # Mot assigne None
& Config_SCI6 0 aN010 # Mot assigned # Not assigne None
v & S[ngle Scan Mode S12AD [0 ano1 # Not assigned 7 Mot assigne Mone
@ Config S12AD0 [0 ANo12 # Not assigned # Not assigne None
[0 aN013 # Not assigned # Mot assigne None
[0 ANO14 7 Not assigned 7 Mot assigne Mone
0 aN01s # Not assigned # Not assigne None
[0 ANO16 # Not assigned # Mot assigne Mone
[0 AN017 7 Not assigned # Not assigne None
] AN018 # Not assigned # Not assigne Mone
[0 AND19 # Not assigned # Not assigne None
[0 ANO20 # Not assigned # Not assigne None
0 ANo21 r Not assigned # Not assigne None
[0 AND22 # Not assigned # Not assigne None
] AN023 7 Not assigned # Not assigne None
D VREFHO 7 Not assigned 7 Mot assigne None
[0 VREFLO # Not assigned # Mot assigne None
< >
Pin Function Pin Number
Figure 4-53 Configure pin assignment - Config_S12ADO0
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Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘®lGenerate Code’ at location of Figure 4-54.

o
Pin configuration =
Generate Code | Generate Report

Figure 4-54 Generate Code Button

The Console pane should report ‘Code generation is successful’, as shown Figure 4-55 below.

ISmart Configurator Ou:cpu‘t
MO400ePO1: File generated:src\smc gen\Config SCI6\Config SCI6.c ~
MO4000001: File generated:src\smc gen\Config SCI6\Config SCI6 user.c
MO4000001: File generated:src\smc gen\Config S12AD@\Config S12AD@.h
MO4000001: File generated:src\smc gen\Config S12AD@\Config S12AD@.c
MP4000001: File generated:src'smc gen\Config S12AD@\Config S12AD@ user.c
MO4000001: File generated:src\smc gen\general\r cg macrodriver.h

MO400OO01: File generated:src\smc gen\general\r cg userdefine.h

MO4000001: File generated:src\smc gen\general\r smc entry.h

MP4000Ra1: File generated:srch\smc gen‘\general\r cg hardware setup.c
MO400RRA1l: File generated:src\smc gen‘\general\r cg cmt.h

MOAGERRA1: File generated:src\smc gen‘\generall\r cg icu.h

MOA000001: File generated:src\smc gen‘\generall\r c ort.h

MO400eO01: File generated:src\smc gen\general\r cg sl2ad.h

MO4000OO1: File generated:src\smc gen'\generall\r cg sci.h

MO5000012: File generated:src\smc gen\r pincfg\Pin.h

MO5000012: File generated:src\smc gen\r pincfg\Pin.c

MO6000O2: File generated:src\smc gen\generallr smc interrupt.c

MO6000002: File generated:srcismc gen\general\r smc interrupt.h

MO600e002: File generated:src\smc gen\r config\r bsp interrupt config.h
M23000004: File modified:src\smc gen\r configh\r bsp config.h

MOBeeeRa2: Code generation is successful:C:\Workspace\SC Tutorial\src\smc gen

Figure 4-55 Smart Configurator console

4.8 Building the Project

The project template created by Smart Configurator can now be built. In the Project Explorer pane expand the
‘src’ folder then smc_gen folder.

~ 15 SC_Tutorial [HardwareDebug]
a Includes

v B src

v [ smc_gen
& Config_CMTOD
& Config_CMT1
& Config_CMT2
& Config_ICU
= Config_PORT
= Config_S12AD0
= Config_SC10
= Config_SCl6
= general
& r_bsp
& r_config
& r_pincfg
& 5C_Tutonal.c
= trash
i 5C_Tutonal.scfg
SC_Tutorial HardwareDebug.launch

Figure 4-56 Generated folder structure

Switch back to the ‘C/C++’ perspective using the B button on the top right of the e? studio workspace.

Select SC_Tutorial in the Project Explorer pane, then use ‘Build Project’ from the ‘Project’ menu or the
button to build the tutorial. The project will build with no errors.
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5. User Code Integration

In this section, the remaining application code is added to the project. Source files found in the RSK Web
Installer are copied into the workspace and the user is directed to add code in the user areas of the code

generator files.

Code must be inserted into the user code area within many Smart Configurator-generated files in this project,
these user code areas are delimited by comments as follows:

/* Start user code for _xxxxx_.
/* End user code.

Do not edit comment generated here */
Do not edit comment generated here */

Where xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user subsequently needs to use Smart Configurator to regenerate any of the Smart

Configurator-generated code.

5.1 Project Settings

e Change the optimization level of the
build configuration 'HardwareDebug'
before building the project. With the
SC_Tutorial project selected, right-
click and select [Properties], or use
the shortcut keys [Alt] + [Enter] to
open the Properties window.

B Project Explorer »

~ 15 SC Tutorial [HardwareDet---"

¥ Binaries
e Includes
v B src

= smc_gen
& SC_Tutonal.c

= HardwareDebug

& trash
SC_Tutonal.rcpe

& SC_Tutonal.scfg
SC_Tutonal HardwareD

Mew
Go Into

Open in New Window
Show In

Show in Local Terminal
Copy

Delete

Source

Rename..

Impaort...

i Export..

3# 0

=

L R

Build Project
Clean Project
Refresh

Close Project

Close Unrelated Project

Build Targets

Index

Build Configurations

Run As

Debug As

Team

Compare With

Restore from Local Histony..
MISRA-C

C/C++ Project Settings
Renesas C/C++ Project Settings
Run C/C++ Code Analysis
System Explorer

Command Prompt
Configure

Properties

Alt+Shift+W >
»

Ctri+C
Ctrl+V
Delete

>

F2

F5

>

Ctri+Alt+P
»

Alt+Enter
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¢ Navigate to ‘C/C++ Build -> Settings
->Compiler -> Optimization.

e Select 'Level 0: Do not perform
optimization' from the Optimization
level pull-down.

Settings

Configuration: HardwareDebug [ Active | ~| | Manage Configurations..

® Tool Settings Toolchain Device /* Build Steps * Build Artifact [l Binary Parsers @ Error Parsers

» Common
=)
(2 PIC/PID
3 Miscellaneous
 ® Compiler
~ (% Source
& Advanced
@ Object
& List
~ (% Optimization
(3 Advanced

Optimization level (-optimize)

] Outputs additional information for inter-module optimization (-goptimize) rform optimization

| optimization
Optimization type (-speed/-size) e module optimization
Level max: Perform all applicable optimizations

Perform loop optimization (-160p)

Performs inline expansion automatically (-inline/-noinline) Depends on the optimization option

Reduces code size of relative branch instructions (-branch_chaining/-nobranch_chaining) | Depends on the optimization option v

e Press the ‘Apply and Close’ button to
close Properties window.

Apply and Close Cancel
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5.2 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-ascii.c
-ascii.h
-r_okaya_lcd.c
-r_okaya_lcd.h

Copy these files in to the src folder below the workspace. These files will be automatically added to the

project as shown in Figure 5-1.

w =% SC_Tutorial [HardwareDebug]
[l Includes
v [ src

(= smc_gen
[ ascii.c
[B] asciih
@ r_okaya_lcd.c
r_okaya_lcd.h
[ SC_Tutorial.c

Figure 5-1 Adding files to the project

In the e? studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h’ by
double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for macro define. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area for include near the top of the file:
/* Start user code for include. Do not edit comment generated here */
#include "platform.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the type define.
/* Start user code for type define. Do not edit comment generated here */
typedef char char t;

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src’ folder and open the file ‘SC_Tutorial.c’ by double-clicking on it.
Add header files near the declaration ‘#include r_smc_entry.h’.

#include "r smc entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
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Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main (void)

{
/* Initialize the debug LCD */
R LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)" RSKRX660 ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");
while (1U)

{

}

Indentation is lost when the code described in this manual is pasted into the e? studio source file. Also check that
the pasted code is correct.
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5.21 SPICode

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in section
4.6.6. In the e? studio Project Tree, expand the ‘src\smc_gen\Config_SCI6’ folder and open the file
‘Config_SCI6.h’ by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI6 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */
Now, open the Config_SCI6_user.c file and insert the following code in the user area for global:
/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t s _sci6_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI6:

static void r Config SCI6 callback transmitend(void)
{
/* Start user code for r Config SCI6 callback transmitend. Do not edit comment generated here */

s_sci6 txdone = TRUE;

/* End user code. Do not edit comment generated here */

}

Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

R KKK KKK KKK KA A KK KKK KKK KKK KKK A A A KKK KK KKK AAA AL A A A A KKK KKK KKK K KKK LA A KKKk k kKKK K *

* Function Name: R _SCI6_ SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments ¢ tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD_OK or MD_ARGERROR

*******************************************************************************/
MD STATUS R SCI6 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num)

{
MD STATUS status = MD OK;

/* Clear the flag before initiating a new transmission */
s sci6 txdone = FALSE;

/* Send the data using the API */
status = R Config SCI6 SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s sci6_txdone)
{
/* Wait */
}

return (status);

}

VAR AR EEEEE RS R AR EEEEE e AR R R

* End of function R SCI6 SPIMasterTransmit
*******************************************************************************/

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD and is used as the main API call in the LCD code module.
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5.22 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in section 4.6.2. Open the file
‘src\smc_gen\Config_ CMTO0\Config CMTO0.h’ and insert the following code in the user area for function at the
end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ CMTO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8 t s one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config_ CMTO_cmiO_interrupt function and insert the following line in the user code area:

static void r Config CMTO cmiO_ interrupt (void)
{
/* Start user code for r Config CMTO0 cmiO interrupt. Do not edit comment generated here */

s_one ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

JE KKK KKK A KK KKK KK I I I KKK KKK KKK I I I AAAAAA A A I A K I KK KKK AAAAAA A A Ak k ok h ok h kA XA

* Function Name: R CMT MsDelay
* Description : Uses CMTO to wait for a specified number of milliseconds
* Arguments : uintl6 t millisecs, number of milliseconds to wait
* Return Value : None
****************************************k*k*****k*k*k*k*k*k‘k‘k*************************k*k/
void R_CMT MsDelay (const uintlé t millisec)
{
uintl6é_t ms_count = 0;

do
{
R Config CMTO Start();
while (FALSE == s_one ms_delay complete)
{
/* Wait */
}
R _Config CMTO_Stop();
s_one_ms_delay complete = FALSE;
ms_count++;
} while (ms_count < millisec);

}

/*******************************************************************************

End of function R CMT MsDelay

Kk ko k ok ok kKA AR Ak ok ok ki h kAR AR A A A KK KKK KKK AAAAAAA A A A KKK KKk kKKK KKK XAA KK Kk kK /
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5.3 Additional include paths

Before the project can be built the compiler needs some additional include paths added. Select the
SC_Tutorial project in the Project Explorer pane. Right click in the Project Explorer window and select

'Properties’. Navigate to ‘C/C++ Build -> Settings ->Compiler -> Source and click the €] button as shown in
Figure 5-2.

8 Properties for SC_Tutorial 0 x ‘
type filter text Settings rDw
Resource —
Builders ~ & Common Include file directories (-include) ISR TR { ~
v €/C++ Build &cu ${TCINSTALL}/include 7
Build Variables & PIC/PID "${workspace_loc:/${ProjName}/src/smc_gen/Config_CMTO}"
(2 Miscellaneous “${workspace_loc/${ProjName}/src/smc_gen/Config_SCI10}
Emironment + ® Compiler Siworkspace_loc:/${ProjName}/src/sme_gen/Config_SCI6}
Logging « i ${workspace_loc/${ProjNamel/src/sme_gen/general)”
Settings B Advanced ${iworkspace_loc/${ProjName}/src/smec_gen/Config_CMT2)
Stack Analysis e ‘${workspace_loc//${ProjName}/src/sme_gen/Config_CMT1}"
Tool Chain Editor @ Object “${workspace_loc/${ProjName}/src/sme_gen/Config_ICU)
C/Ca4 General & List "${workspace_loc/${ProjName}/sic/smc_gen/Config_S12AD0}
Proiect Natures ~ (& Optimization “${workspace_loc:/${ProjName}/src/smec_gen/Config_PORT}"
4 (& Advanced “${workspace_loc:/${ProjName}/src/smc_geny/r_pincfg)”
fioyect Reterences & Qutput “${workspace_loc:/${ProjName}/src/smc_gen/r_bsp}”
Rs E =€ fuindrrinen ki MBIl ferrdome nonde ~aniel™ o
S (2 MISRA C Rule Check | L o
Run/Debug Settings B L b Pre-include files (-preinciude) €
(5 User
v & Assembler i
@ Apply and Close Cancel

Figure 5-2 Adding additional search paths

In the ‘Add directory path’ dialog, click the ‘Workspace...” button and in the ‘Folder selection’ dialog browse to
the ‘SC_Tutorial/src’ folder and click ‘OK’. e? studio formats the path as shown in Figure 5-3 below.

{8} Add directory path ped

Directory:

${workspace_loc:,/${ProjNamel/src)

[] Add subdirectories

OK Cancel File system...

Figure 5-3 Adding workspace search path

Close the property by clicking the 'Apply and Close' button shown in Figure 5-2, and when the 'Settings'
dialog shown in Figure 5-4 is appeared, click 'Yes' to finish the setting.

=

Changes made will not be reflected in the index until it is rebuilt. Do you wish to rebuild it
now?

[] Remember my decision

Yes No

Figure 5-4 Settings dialog

Select ‘Build Project’ from the ‘Project’ menu or use the ﬁ button. e? studio will build the project with no
errors.

The project may now be run using the debugger as described in section 6. The program will display
‘RSKRX660 Tutorial Press Any Switch’ on three lines in the LCD display.
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5.4 Switch Code Integration

API functions for user switch control are provided with the RSK. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-rskrx660def.h
r_rsk_switch.c
-r_rsk_switch.h

Copy these files in to the src folder below the workspace.

The switch code uses interrupt code in the files Config_ICU.h, Config_ICU.c and Config_ICU_user.c and timer
code in the files Config_ CMT1.h, Config_ CMT1.c, Config_CMT1_user.c, Config_ CMT2.h, Config_ CMT2.c and
Config_ CMT2_user.c as described in section 4.6.2. and section 4.6.3 It is necessary to provide additional
user code in these files to implement the switch press/release detection and de-bouncing required by the API
functions in r_rsk_switch.c.

5.4.1 Interrupt Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_ICU’ folder and open the file ‘Config_ICU.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */

uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no);

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge);

void R_ICU TRQSetRisingEdge (const uint8_t irqg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */
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Now, open the Config_ICU.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************

* Function Name: R ICU IRQIsFallingEdge

Description : This function returns 1 if the specified ICU IRQ is set to
* falling edge triggered, otherwise 0.
* Arguments : uint8 t irqg no

* Return Value : 1 if falling edge triggered, 0 if not

*******************************************************************************/
uint8 t R ICU IRQIsFallingEdge (const uint8 t irg no)
{ uint8 t falling edge trig = 0x0;

if (ICU.IRQCR[irg no].BYTE & 04 ICU IRQ EDGE FALLING)

{ falling edge trig = 1;

}

return (falling edge trig);

}

KKK K K K K Kk K KR K K K R K K K R K K K R K K R R K K R kK R K K ok Kk ok Kk ok ok K R ok Kk ok kK K ok Kk ok Kk R kK ok ok kR kK ok ok ok

* End of function R _ICU IRQIsFallingEdge

*******************************************************************************/

KK KKK Kk K K K K R K K K ok K K ok K K R R K K R K K K ok K R ok K ok K K K ok Kk o ok K ok K K R K K K ok K K R ok K R Kk R R Kk ok K Kk k

* Function Name: R _ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU_ IRQ.

* Arguments : uint8 t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if
* clearing

* Return Value : None
*******************************************************************************/

void R _ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{
if (1 == set_f edge)
{
ICU.IRQCR[irg nol] .BYTE |= 04 ICU IRQ EDGE FALLING;
}

else

{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 04 ICU IRQ EDGE FALLING;

}

VAR AR EEEEEE RS AR AR EEEE AR R E R R R AR R

* End of function R_ICU_IRQSetFallingEdge

*******************************************************************************/

VAR EEEE RS E e AR EEEEEE AR E R

* Function Name: R_ICU_ IRQSetRisingEdge

* Description : This function sets/clear the rising edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set r edge, 1 if setting rising edge triggered, 0 if

* clearing

* Return Value : None
*******************************************************************************/

void R_ICU IRQSetRisingEdge (const uint8 t irg no, const uint8 t set r edge)
{
if (1 == set_r_edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE_RISING;
}
else

{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;

}

/******************************************************************************

* End of function R ICU IRQSetRisingEdge

******************************************************************************k/

/* End user code. Do not edit comment generated here */
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Open the Config_ICU_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irq9_interrupt:

/* Start user code for r Config ICU irqg9 interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R _SWITCH IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg10_interrupt:

/* Start user code for r Config ICU irqgl0O interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R_SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */

5.4.2 De-bounce Timer Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config CMT1" folder and open the
‘Config_ CMT1_user.c’ file and insert the following code in the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the Config_ CMT1_user.c’ file, insert the following code in the user code area inside the function
r_Config_CMT1_cmi1_interrupt:

/* Start user code for r Config CMT1 cmil interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R _Config CMT1 Stop();

/* Call the de-bounce call back routine */
R _SWITCH DebounceIsrCallback();

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src\smc_gen\Config CMT2' folder and open the file
‘Config_ CMT2_user.c’ file and insert the following code in the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */
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In the same file insert the following code in the user code area inside the function
r_Config_CMT2_cmi2_interrupt:

/* Start user code for r Config CMT2 cmi2 interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT2 Stop();

/* Call the de-bounce call back routine */
R_SWITCH DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

543 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In section 4.6.7 we configured the ADC to be triggered from the ADTRGO0# pin, SW3.
In this code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the e2 studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h’.
Insert the following code the user code area, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */
extern volatile uint8_t g _adc_trigger;

/* End user code. Do not edit comment generated here */

In the e2 studio Project Tree, expand the ‘src’ folder and Open the file ‘SC_Tutorial.c’ and add the highlighted
code, resulting in the code shown below:

#include
#include
#include "r cg ucs >
#include "Config S12ADO.h"
#include "r rsk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb_switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6é t adc result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the
code shown below:

void main (void)

{
/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R_LCD Init ();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSKRX660 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0O_Start();

while (10U)
{
uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1l or SW2) */
if (TRUE == g adc_ trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
lcd display adc (adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}
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Then add the definition for the switch call-back, get_adc and lcd_display_adc functions below the main

function, as shown below:

/******************************************************************************

* Function Name : cb switch press

* Description : Switch press callback function. Sets g adc trigger flag.
* Argument ¢ none
* Return value : none

LR R EEEEEE SRR EEEEE LR R R R RS EEE R

static void cb_switch press (void)

{
/* Check if switch 1 or 2 was pressed */
if (g_switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))
{

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_ flag = 0x0;
}
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k*********************‘k‘k‘k‘k‘k‘k*************‘k‘k‘k********‘k‘k‘k‘k‘k‘k‘k‘k**********

* End of function cb switch press
******************************************************************************/

/~k~k~k~k~k***********************************************~k~k************************

Function Name : get adc
* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.
* Argument : none
* Return value : uintlé_t adc value

******************************************************************************/
static uintlé t get adc (void)

/* A variable to retrieve the adc result */
uintl6é_t adc result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R Config S12AD0 Stop();

/* Start a conversion */
R S12AD0_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g adc complete)
{
/* Wait */
nop () ;
}

/* Stop conversion */
R_S12AD0_SWTriggerStop () ;

/* Clear ADC flag */
g_adc_complete = FALSE;

R _Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R Config S12AD0_Start();

return (adc_result);

}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k*******‘k‘k‘k‘k‘k‘k‘k**********‘k‘k‘k‘k‘k‘k‘k*********‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k********‘k*****‘k‘k

* End of function get adc
khkkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhkhhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhkhhhhhhhhhkhhkhkhhhkhkhhhhhhhhhhhhkhkhkhkhkhkkkhkkhkkkkk
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/******************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6_t adc result

* Return value : none

******************************************************************************/
static void lcd display adc (const uintl6 t adc result)

{
/* Declare a temporary variable */
char t tmp;

/* Declare temporary character string */
char t lcd buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

tmp = (char t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_t) ((adc_result & 0xO00F0) >> 4);

lcd buffer[7] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_t) (adc_result & 0x000F);

lcd buffer[8] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);

/* Display the contents of the local string lcd buffer */
R_LCD Display(3, (uint8 t *)lcd buffer);
}

/**k*****k*********k******************************************kk***************

* End of function lcd display adc

******************************************************************************/

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_S12AD0’ folder and open the file

‘Config_S12AD0.h’ by double-clicking on it. Insert the following code in the user
resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R S12AD0 SWTriggerStart (void);
void R_S12AD0_SWTriggerStop (void) ;

/* End user code. Do not edit comment generated here */

code area for function,
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Open the file ‘Config_S12ADO0.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************
* Function Name: R_S12AD0_SWTriggerStart

* Description : This function starts the ADO converter.

* Arguments : None

* Return Value : None
*******************************************************************************/

void R _S12AD0_SWTriggerStart (void)

{
IR(S12ADCO, S12ADIO0) = 0U;
IEN (S12ADCO, S12ADIO) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;
}

JE KKK KKK KKKk h ki h Kk kKA A AR KR KA A K KKK I I I A A AR AKX A A KAk Ak ok hh kA AR XA A I KAk ok ok khh kA XXX

End of function R S12AD0 SWTriggerStart

*******************************************************************************/

JE KKK KKK KKK KKKk hh kI I A AR AR Kk hhhh kA A AR A A A A I KA A KKK I I A AARA XA A A Kk kkkhh kA A A XX

* Function Name: R _S12AD0 SWTriggerStop
* Description : This function stops the ADO converter.
* Arguments : None

* Return Value : None
*******************************************************************************/

void R_S12AD0_SWTriggerStop (void)

{
S12AD.ADCSR.BIT.ADST = 0U;
IEN (S12ADCO, S12ADIO) = 0U;
IR(S12ADCO, S12ADIO) = 0U;

}

VAR AR RS R R SRR AR AR AR RS Rt EEEEE Rt EEEE R Rt

End of function R S12AD0_ SWTriggerStop

*******************************************************************************/

/* End user code. Do not edit comment generated here */

Open the file Config_S12ADO0_user.c and insert the following code in the user code area for global, resulting in
the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_ S12ADO0 _interrupt function, resulting in the
code shown below:

static void r Config S12AD0_interrupt (void)
{

/* Start user code for r Config S12AD0O interrupt. Do not edit comment generated here */
g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

-

Select ‘Build Project’ from the ‘Project’ menu or use the button. e? studio will build the project with no
errors.

The project may now be run using the debugger as described in section 6. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the RV1 potentiometer line and display the
result on the LCD panel. Return to this point in the Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Check that the following files are in the
src folder:

-r_rsk_debug.c

r_rsk_debug.h

Copy these files in to the src folder below the workspace.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL DEBUG WRITE (R SCI10 AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration
5.6.1 SCI Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_SCI10’ folder and open the file
‘Config_SCI10.h’ by double-clicking on it. Insert the following code in the user code area at the end of the file:
/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R _SCI10_ AsyncTransmit (uint8 t * const tx buf, const uintl6_t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI10_user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g rx char;

/* Flag used locally to detect transmission complete */
static volatile uint8 t s SCI10_ txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI10_callback_transmitend function:
static void r Config SCI10 callback transmitend (void)
{
/* Start user code for r Config SCI10 callback transmitend. Do not edit comment generated here */

s _SCI10 txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area inside the
r_Config_SCI10_callback_receiveend function:

static void r_Config SCI10_callback receiveend(void)

{

/* Start user code for r Config SCI10_callback receiveend. Do not edit comment generated here */

/* Check the contents of g _rx char */
if (('c' == g rx char) || ('C' == g rx char))
{
g_adc_trigger = TRUE;
}

/* Set up SCI10 receive buffer and callback function again */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/*******************************************************************************

* Function Name: R_SCI10_AsyncTransmit

* Description : This function sends SCI10 data and waits for the transmit end flag.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD OK or MD ARGERROR

*******************************************************************************/
MD STATUS R_SCI10_AsyncTransmit (uint8_t * const tx buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
s_SCI10_txdone = FALSE;

/* Send the data using the API */
status = R Config SCI10_Serial_ Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == s_SCI10_txdone)
{
/* Wait */
}
return (status);

}

/*******************************************************************************

* End of function R SCI10 AsyncTransmit

*******************************************************************************/

5.6.2 Main UART code

Open the file ‘SC_Tutorial.c’. Add the following declaration to near the top of the file:

#include "r smc entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI10.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb_switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);
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/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc_ result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s_adc_count = 0;

Add the following highlighted code in the main function:

void main (void)

{
/* Initialize the switch module */
R _SWITCH Tnit();

/* Set the call back function when SWl or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display(0, (uint8 t *)" RSKRX660 ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R _Config S12AD0_Start();

/* Set up SCI10 receive buffer and callback function */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI10 operations */
R Config SCI10 Start();

while (10)
{

uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SWl1 or SW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s_adc count */
if (16 == (++s_adc_count))
{

s_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(s_adc_count, adc result);

/* Reset the flag */

g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g _adc_complete)
{

/* Get the result of the A/D conversion */
R_Config S12AD0O_Get_ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc result);

/* Increment the s_adc count */
if (16 == (++s_adc_count))
{

s_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(s_adc_count, adc_result);
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/* Reset the flag */
g adc_complete = FALSE;
}
else
{
/* do nothing */
}

Then, add the following function definition in the end of the file:

JRF kK k k kA A ARk Kk kI A AAAA A I KKK KKK I KKK KKK Kk h ok hh kA A A KKK K&K KKKk kkk

* Function Name : uart display adc
* Description : Converts adc result to a string and sends it to the UART.
* Argument : uint8 t : adc count

*

uintlé t: adc result

* Return value : none
******************************************************************************/

static void uart display adc (const uint8 t adc count, const uintl6 t adc result)

{

}

/* Declare a temporary variable */
char_t tmp;

/* Declare temporary character string */
char t uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

tmp = (char_t) (adc_count & 0x000F);

uart buffer[4] = (tmp < O0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char t) ((adc_result & 0x0F00) >> 8);

uart buffer[l4] = (tmp < O0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char t) ((adc_result & 0x00F0) >> 4);

uart buffer[15] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_t) (adc_result & 0x000F) ;

uart buffer[l6] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);

/* Send the string to the UART */
r _debug print (uart buffer);

/*******************************‘k‘k‘k‘k*******************************************

* End of function uart display adc
**************‘k‘k‘k‘k‘k**‘k‘k‘k‘k******‘k‘k‘k***************‘k‘k‘k‘k‘k‘k*****‘k‘k‘k***************/

Select ‘Build Project’ from the ‘Project’ menu. e? studio will build the project with no errors.

The project may now be run using the debugger as described in section 6. Connect the RSK G1CUSBO port
to a USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will
be installed automatically. Open Device Manager, the virtual COM port will be appeared under 'Port (COM &
LPT)" as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI10 (Baudrate:
19200, Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None).

When any switch is pressed, or when ‘¢’ is sent via the COM port, the program will perform an A/D conversion

of the voltage level on the RV1 potentiometer line and display the result on the LCD panel and send the result
to the PC terminal program via the SCI10.
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5.7 LED Code Integration

Open the file ‘SC_Tutorial.c’. Add the following declaration to the near the top of the file:

#include "r smc entry.h"
finclude "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
finclude "Config SCI10.h"
#include "rskrx660def.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6_t adc_result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s adc count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

Add the following highlighted code in the main function:

void main (void)

{
/* Initialize the switch module */
R_SWITCH Tnit();

/* Set the call back function when SW1l or SW2 is pressed */
R _SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSKRX660 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI10 receive buffer and callback function */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI10 operations */
R Config SCI10 Start();

while (10U)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc_result);
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/* Increment the s _adc count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display_count (s_adc_count) ;

/* Send the result to the UART */

uart display adc(s_adc_count, adc result);

/* Reset the flag */

g _adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g adc complete)
{

/* Get the result of the A/D conversion */

R_Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s_adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s _adc count);

/* Send the result to the UART */
uart display adc(s_adc count, adc result);
/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}

Then, add the following function definition at the end of the file:

VAR AR EEEE St AR R EEE RSt EE RSt AR EEEE Rt

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDSO0-3
* Argument : uint8 t count

* Return value : none

LR R EEEEEE SRR EEEE SRR EEEE et EE SRR

static void led display count (const uint8 t count)

{

/* Set LEDs according to lower nibble of count parameter */

LEDO = (uint87t)((count & 0x01) 2 LED ON : LED OFF);
LED1 = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8 t) ((count & 0x04) ? LED ON : LED OFF);

LED3 (uint8_t) ((count & 0x08) ? LED ON : LED_OFF);

}

/************************************************~)<~)<~)<~)<~)<~)<************************

* End of function led display count

ke k kK ok ke sk ok sk ok ok ok ke sk ok sk ok ok ok ok ok ok sk ok ok sk ke ok ok sk ok ok ok ok sk ok sk ok ok ok ok sk ok ok ok ok sk ok ok ok sk ok ok ok ok sk ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok

%

Select ‘Build Project’ from the ‘Project’ menu or use the
errors.

" button. e? studio will build the project with no

The project may now be run using the debugger as described in section 6. The code will perform the same

but now the LEDs will display the s_adc_count in binary form.
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6. Debugging the Project

In the Project Explorer pane, ensure that the ‘SC_Tutorial’ project is selected. To enter the configurations,

click upon the arrow next to the debug button: #‘FE and select ‘Debug Configuration’.

| Create, manage, and run configurations @
)

ERBMEIEY v Name: [SC_Tutorial HardwareDebug
ype fitter text B > Debugger & Startup| - Source| I Common

1 C/C++ Application

- Project:
£] C/C++ Remote Application

EASE Seript SC_Tutorial S
[€] GDB Hardware Debugging ¢/C++ Application:

|
|

|| [ GDB Simulator Debugging (RHB30)
| ;_J A' ‘u g ugging { HardwareDebug/SC_Tutorial x

I i s Variabl Search Project. B

| T] Java Application faniables... arch Project... TOWSE...
|
|

& Launch Group Build (if required) before launching
T, Remote Java Application

TR Build Configuration: | Select Automaticall Ld
|| ~ EI Renesas GDB Hardware Debugging - 2
7 SC_Tutorial HardwareDebug (O Enable auto build () Disable auto build
[E7] Renesas Simulator Debugging (RX, RL78) (® Use workspace settings Configure Workspace Settings...

Filter matched 12 of 14 items

Figure 6-1 Debug Configurations

In order to execute the project, it is necessary to change the following settings in ‘Renesas GDB Hardware
Debugging’ -> ‘SC_Tutorial HardwareDebug’ -> ‘Debugger’ -> ‘Connection Settings’.

Set ‘Power Target From The Emulator (MAX 200mA)’ to ‘Yes’, set ‘Extal Frequency [MHz] and 'Operating
Frequency [MHZz]' to the correct frequency. (They should not use the 'Enter' key after typing in values.)

These can be found from the device schematics (in the case of RSKRX660 set the EXTAL Frequency:
24.0000, Operating Frequency: 120.000).

For more information on powering the RSKRX660 please refer to the User's Manual.

Name: | Tutorial HardwareDebug

Main— ¥ Startup | ] Commeon| &+ Source

Debug hardware: E2 Lite (RX) ~| Target Device: R5F56609H
GDB Settings Debug Tool Settings
~ Clock P
Main Clock Source EXTAL v
Extal Frequency[MHz] 24
Operating Frequency [MHz] 120.000
Permit Clock Source Change On Writing Internal Flash Memory Yes ]
~ Connection with Target Board
Emulator (Auto)

Connection Type
JTag Clock Frequency|MHz]

<

Fine Baud Rate[Mbps] 1.50 v
Hot Plug No v
v Power

Power Target From The Emulator (MAX 200mA) Yes v
Supply Voltage (V) 3
~ CPU Operating Mode

Register Setting Single Chip v
Mode pin Single-chip mode v
Change startup bank I

Startup bank Bank O W

Figure 6-2 Connection Settings

When the setting is complete, press the 'Apply' button followed by the "Close" button to close the debug
configuration window.

R20UT5023EG0100 Rev.1.00 RENESAS Page 71 of 76
Jan.17.2022



Renesas Starter Kit for RX660 6. Debugging the Project

Connect the E2 Lite to the PC and the RSK E2 Lite connector. Connect the Pmod LCD to the PMOD1
connector. Connect the center positive +5V PSU to the PWR connector on the RSK and apply power.
In the Project Explorer pane, ensure that the ‘SC_Tutorial’ project is selected. To debug the project, click the

button. The dialog shown in Figure 6-3 will be displayed.

b

'o This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective supports application debugging by providing views for displaying
the debug stack, vanables and breakpoints.

Switch to this perspective?

[] Remember my decision

[

Figure 6-3 Perspective Switch Dialog

Click ‘Remember my decision’ to skip this dialog later. Click ‘Switch’ to confirm that the debug window
perspective will be used. The debugger will start up and the code will stop at the Smart Configurator function
‘PowerOn_Reset PC’ as shown in Figure 6-4.

Q Workspace - SC_Tutorial/src/sme_gen/r_bsp/meu/all/resetprg.c - e* studio

File Edit Source Refactor Mavigate Search Project Renesas Views Run Window Help

% |4 || ™ | % Debug v || E SC_Tutorial HardwareDebug s W R w0 mN
e fl et - - |
1 Debug > = i+ 1

~ [ SC_Tutorial HardwareDebug [Renesas GDB Hardware Debugging]
v ¥ SC_Tutorialx [1] [cores: 0]
v o Thread #1 1 (single core) [core: 0] {Suspended : Signal : SIGTRAP:Trace/breakpoint trap)
= PowerQON_Reset_PC() at resetprg.c:192 Oxfff02fa5
wi me-elf-gdb -ne-force-isa=v3 (7.8.2)
wl Renesas GDB server (Host)

B resetprg.c X 1

5 100 fif02fa5 -R_BSP_POR_FUNCTION(R_BSP_STARTUP_FUNCTION)
* Stack pointers are setup prior to calling this function - see comments ab
/* You can use auto variables in this function but such variables other than
* will be unavailable aft you change the stack from the I stack to the L
(* The bss sections have not been sared and the data sections have not bee

* and constructors of C++ objec ave not been executed until the _INITSCT
#if defined(_ GNUC_ )
#if BSP_CFG_USER_STACK_ENABLE ==

) INTERMAL_MOT_USED(ustack_area);

Figure 6-4 Debugger start up screen

For more information on the e? studio debugger refer to the Tutorial manual. To run the code click the L
button. The debugger will stop again at the beginning of the main function. Press ¥ again to run the code.
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7. Additional Information

Technical Support

For details on how to use e? studio, refer to
the help file by opening e? studio, then :
selecting Help > Help Contents from the 0~ B WO f

menu bar. (7). Help Contents
Search

Show Context Help |

Window Help

For information about the RX660 group microcontroller refer to ‘RX660 Group User’s Manual: Hardware’.
For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.

Technical Contact Details
America: techsupport.america@renesas.com

Europe: https://www.renesas.com/eu/en/support/contact.html
Global & Japan: https://www.renesas.com/support/contact.html

General information on this product can be found on the Renesas website at:
https://www.renesas.com/rskrx660

General information on Renesas microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe GmbH.

© 2022 Renesas Electronics Europe GmbH. All rights reserved.
© 2022 Renesas Electronics Corporation. All rights reserved.
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